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The Microfluidics Module

The Microfluidics Module is used by engineers and scientists to understand, 
predict, and design microfluidic systems. The use of simulation tools in the design 
cycle is becoming more widespread as they can improve understanding, reduce 
prototyping costs, and speed up development. The Microfluidics Module allows 
users to quickly and accurately model single-phase flows, multiphase flows, flow 
through porous media, electrokinetic flows, and slightly rarefied gas flows.
The Microfluidics Module can solve stationary and time-dependent flows in 
two-dimensional and three-dimensional spaces. Formulations suitable for 
different types of flow are set up as predefined user interfaces, referred to as 
Microfluidics interfaces. The fluid-flow interfaces use physical quantities, such as 
pressure and flow rate, and physical properties, such as viscosity and density, to 
define a fluid-flow problem. Different interfaces are available to cover a range of 
microfluidic flows. Examples include: laminar flow, creeping flow, two-phase flow 
(phase field, level set, and moving mesh), porous media flow (Darcy’s Law, the 
Brinkman equations, or Free and Porous Media Flow—which combines the 
Brinkman equations with laminar flow) and slip flow. The transport of multiple 
species can also be treated with the Transport of Diluted Species interface. These 
physics interfaces can easily be coupled with, for example, COMSOL’s 
Electrostatics or Electric Currents user interfaces to solve multiphysics problems 
such as electrokinetic flows.
For each of the Microfluidics interfaces, the underlying physical principles are 
expressed in the form of partial differential equations, together with 
corresponding initial and boundary conditions. COMSOL’s design emphasizes 
the physics by providing users with the equations solved by each feature and 
offering the user full access to the underlying equation system. There is also 
tremendous flexibility to add user-defined equations and expressions to the 
system. For example, to model the transport of a species that significantly affects 
the viscosity of the fluid, simply type in concentration-dependent viscosity—no 
scripting or coding is required (this is demonstrated in the tutorial example on 
page 16). When COMSOL compiles the equations the complex couplings 
generated by these user-defined expressions are automatically included in the 
equation system. The equations are then solved using the finite element method 
and a range of industrial-strength solvers. Once a solution is obtained a vast range 
of postprocessing tools are available to interrogate the data, and predefined plots 
are automatically generated to show the device response. COMSOL offers the 
flexibility to evaluate a wide range of physical quantities including predefined 
quantities such as the pressure, velocity, shear rate, or the vorticity (available 
through easy-to-use menus), as well as arbitrary user-defined expressions.
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To model a microfluidic device the geometry is first defined in the software. Then 
appropriate materials are selected and a suitable Microfluidics interface is added. 
Initial conditions and boundary conditions are set up within the interface. Next, 
the mesh is defined—in many cases COMSOL’s default mesh, which is produced 
from physics-dependent defaults, will be appropriate for the problem. A solver is 
selected, again with defaults appropriate for the relevant physics, and the problem 
is solved. Finally the results are visualized. All these steps are accessed from the 
COMSOL Desktop.
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Microfluidic Devices: Physics and Applications

Microfluidic flows occur on length scales that are orders of magnitude smaller than 
macroscopic flows. Manipulation of fluids at the microscale has a number of 
advantages—typically microfluidic systems are smaller, operate faster, and require 
less fluid than their macroscopic equivalents. Energy inputs and outputs are also 
easier to control (for example, heat generated in a chemical reaction) because the 
surface-to-area volume ratio of the system is much greater than that of a 
macroscopic system.
In general, as the length scale (L) of the fluid flow is reduced, properties that scale 
with the surface area of the system become comparatively more important than 
those that scale with the volume of the flow. This is apparent in the fluid flow itself 
as the viscous forces, which are generated by shear over the isovelocity surfaces 
(scaling as L2), dominate over the inertial forces (which scale volumetrically as L3).
The Reynolds number (Re), which characterizes the ratio of these two forces, is 
typically low, so the flow is usually laminar (Re<1000). In many cases the creeping 
(Stokes) flow regime applies (Re«1). Laminar and creeping flows make mixing 
particularly difficult, so mass transport is often diffusion limited. The diffusion 
time scales as L2, but even in microfluidic systems diffusion is often a slow process. 
This has implications for chemical transport within microfluidic systems. The 
figure below shows flow in a device designed to enhance the mixing of two fluids 
in a lamella flow. Pressure contours are shown on the walls of the mixer, and the 
velocity magnitude is shown at the inlets and outlets of the mixer as well as at the 
point where the two sets of channels (carrying different fluids) converge. 
Streamlines (in red) are also plotted. The inset shows the concentration of a 
diffusing species present in only one of the fluids. It is plotted along vertical lines 
located progressively further down the center of the mixer.
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When multiple phases are present, surface tension effects become important 
relative to gravity and inertia at small length scales. The Laplace pressure (the 
pressure jump across a two phase boundary), capillary force, and Marangoni forces 
all scale as 1/L. The figure below shows the break up of oil droplets to produce 
an emulsion as the oil flows into a channel carrying a second fluid. Velocity 
streamlines are shown and the fluid velocity is plotted on the symmetry plane. The 
two-phase boundary is shown in green.



Microfluidic Devices: Physics and Applications | 5

Flow through porous media can also occur on microscale geometries. Because the 
permeability of a porous media scales as L2 (where L is the average pore radius) 
the flow is often friction dominated when the pore size is in the micron range and 
Darcy’s law can be used. For intermediate flows this module also provides a user 
interface to model flows where Brinkman equation is appropriate.
At the microscale a range of electrohydrodynamic effects can be exploited to 
influence the fluid flow. The electric field strength for a given applied voltage 
scales as 1/L, making it easier to apply relatively large fields to the fluid with 
moderate voltages. In electroosmosis the uncompensated ions in the charged 
electric double layer (EDL) present on the fluid surfaces are moved by an electric 
field, causing a net fluid flow. Electrophoretic and dielectrophoretic forces on 
charged or polarized particles in the fluid can be used to induce particle motion, 
as can diamagnetic forces in the case of magnetophoresis. The manipulation of 
contact angles by the electrowetting phenomena is also easy in microscale devices, 
a phenomenon that has been exploited as a basis for various new display 
technologies. The figure below shows an adjustable focus liquid lens, whose radius 
of curvature can be adjusted using the electrowetting effect. The colors show the 
fluid velocity magnitude in a lower, oil filled part of the lens and the arrow plot 
shows the velocity in the liquid above the oil lens.

As the length scale of the flow becomes comparable to intermolecular length scale 
more complex kinetic effects become important. For gases the ratio of the 
molecular mean free path to the flow geometry size is given by the Knudsen 
number (Kn). Clearly, Kn scales as 1/L. For Kn < 0.01 fluid flow is usually well 
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described by the Navier-Stokes equations with no-slip boundary conditions. In 
the slip flow regime (0.01 < Kn < 0.1) appropriate slip boundary conditions can 
be used with the Navier-Stokes equations to describe the flow away from the 
boundary. The Microfluidics Module includes an interface to deal with these 
slightly rarefied gas flows: the Slip Flow interface. For more highly rarefied flows 
the Molecular Flow Module should be used.
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The Microfluidics Module Physics Guide

The Microfluidics physics interfaces are used to set up a simulation problem. Each 
physics interface expresses the relevant physical phenomena in the form of sets of 
partial or ordinary differential equations, together with appropriate boundary and 
initial conditions. Each feature added to the interface represents a term or 
condition in the underlying equation set. These features are usually associated 
with a geometric entity within the model, such as a domain, boundary, edge (for 
3D models), or point. Figure 1 uses the Lamella Mixer model (found in the 
Microfluidics Module Model Library) to show the Model Builder and the settings 
window for the selected Fluid Properties 1 feature node. This node adds the 
Navier-Stokes equations to the simulation within the domains selected. Under the 
Fluid Properties section lists indicate that the fluid density and viscosity are 
inherited from the material properties assigned to the domain. The material 
properties can be set up as functions of dependent variables in the model, for 
example, temperature and pressure. The wall, inlet, symmetry, and outlet 
boundary conditions are also highlighted in the model tree. The Wall boundary 
condition is applied by default to all surfaces in the model and adds a no-slip 
constraint to the flow. The inlet and outlet features include a range of options to 
allow fluid to enter or leave the simulation domain.
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Figure 1: The Model Builder (to the left), and the Fluid Properties1 settings window for the selected 
feature node (to the right). The Equation section in the settings window shows the model equations. The 
terms added to the equation system by the feature are underlined with a dotted line.

The Microfluidics Module includes a number of interfaces for modeling different 
types of microfluidic device. When a new model is started, these interfaces are 
selected from the Model Wizard. Figure 2 shows the Model Wizard with the 
physics interfaces included with the Microfluidics Module highlighted. Also see 
“Physics List by Space Dimension and Preset Study Type” on page 13. Below, a 
brief overview of each of the Microfluidics Module physics interfaces is given.

Highlighted
node shown 
in settings
window

Boundary
conditions

Equations solved
are displayed here

Models imputs define quantities
which are not solved for but
which are required for the
material properties. They can
be linked to another interface.

Material properties can be
automatically imported from
materials defined in the built-in
material library



The Microfluidics Module Physics Guide | 9

Figure 2: The Microfluidics Module physics interfaces as displayed in the Model Wizard. Note that this 
is for 3D models. 
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SINGLE-PHASE FLOW

Microfluidic flows usually occur at low Reynolds numbers. The Reynolds number 
(Re) is a measure of the ratio of the fluid viscous to the inertial forces acting on 
the fluid and is given by: Re=UL/, where  is the fluid density, U is a 
characteristic velocity, L is a characteristic length scale, and  is the dynamic 
viscosity. 
The Laminar Flow interface ( ) applies when the Reynolds number is less than 
approximately 1000. The interface solves the Navier-Stokes equations, for 
incompressible and weakly compressible flows (weakly compressible implies that 
the Mach number (Ma), given by Ma=U/c, where c is the velocity of sound in the 
fluid, is less than 0.3). This fluid-flow interface also allows for simulation of 
non-Newtonian fluid flow.
The Creeping Flow interface ( ) approximates the Navier-Stokes equations for 
the case when the Reynolds number is significantly less than 1. This is often 
referred to as Stokes flow and is appropriate for use when viscous flow is dominant. 
It is usually applicable for microfluidic devices.

MULTIPHASE FLOW

The Two-Phase Flow, Level Set interface ( ), the Two-Phase Flow, Phase Field 
interface ( ), and the Two Phase Flow, Moving Mesh interface ( ) are used to 
model two fluids separated by a fluid interface. The moving interface is tracked in 
detail using either the level set method, the phase field method, or by a moving 
mesh, respectively. The level set and phase field methods use a fixed mesh and 
solve additional equations to track the interface location. The moving mesh 
method solves the Navier Stokes equations on a moving mesh with boundary 
conditions to represent the interface. In this case equations must be solved for the 
mesh deformation. These interfaces support both compressible (Mach number, 
Ma0.3) and incompressible laminar flows, where one or both fluids can be 
non-Newtonian.

POROUS MEDIA AND SUBSURFACE FLOW

The Brinkman Equations interface ( ) models flow through a porous medium 
where shear stresses cannot be neglected. The physics interface supports both the 
Stokes-Brinkman formulation, suitable for very low flow velocities, and 
Forchheimer drag, which is used to account for effects at higher velocities. The 
fluid can be either incompressible or compressible, provided that the Mach 
number is less than 0.3.
The Darcy’s Law interface ( ) models relatively slow flows through porous 
media. Shear stresses perpendicular to the flow are neglected.
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The Free and Porous Media Flow interface ( ) models both porous media 
(using the Brinkman Equations) and laminar flow, automatically providing the 
coupling between them.
These interfaces are appropriate for microfluidic porous media flow. Example 
applications include paper microfluidics and transport in biological tissue.

TRANSPORT OF DILUTED SPECIES

The Transport of Diluted Species interface ( ) simulates chemical species 
transport through diffusion, convection (when coupled to fluid flow), and 
migration in electric fields for mixtures where one component, a solvent, is present 
in excess (90 mol% or greater). It is typically employed to model the performance 
of mixers. For modeling chemical reactions in microfluidic devices the chemical 
reaction engineering module is recommended.

RAREFIED GAS FLOWS

Rarefied gas flow occurs when the mean free path, , of the molecules becomes 
comparable with the length scale of the flow, L. The Knudsen number, Kn=/L, 
characterizes the importance of rarefaction effects on the flow. As the gas becomes 
rarefied (corresponding to increasing Knudsen number), the Knudsen layer, 
which is present within one mean free path of the wall, begins to have a significant 
effect on the flow. For Knudsen numbers below 0.01 rarefaction can be neglected, 
and the Navier Stokes equations can be solved with non-slip boundary conditions 
(the Laminar Flow ( ) or Creeping Flow ( ) interfaces can be used in this 
instance). For slightly rarefied gases (0.01<Kn<0.1), the Knudsen layer can be 
modeled by appropriate boundary conditions at the walls together with the 
continuum Navier-Stokes equations in the domain. In this instance the Slip Flow 
interface ( ) is appropriate. To model higher Knudsen numbers the Molecular 
Flow Module is required. The figure below shows how high Knudsen numbers 
can be obtained either by reducing the size of the geometry, or by reducing the 
pressure or number density of the gas.
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Figure 3: Plot showing the main fluid flow regimes for rarefied gas flows. Different regimes are separated 
by lines of constant Knudsen number. The number density of the gas is normalized to the number density 
of an ideal gas at a pressure of 1 atmosphere and a temperature of 0° C (n0).

Continuum 
Flow

Slip Flow

Transitional 
Flow

Free 
Molecular 
Flow
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Physics List by Space Dimension and Preset Study Type
The table below list the physics interfaces available specifically with this module in 
addition to the COMSOL Multiphysics basic license.

Physics Icon Tag Space 
Dimension

Available Preset Study 
Type

 Chemical Species Transport

Transport of Diluted Species* chds all dimensions stationary; time 
dependent

Species Transport in Porous 
Media

chpm all dimensions stationary; time 
dependent

 Fluid Flow

 Single-Phase Flow

Laminar Flow* spf 3D, 2D, 2D 
axisymmetric

stationary; time 
dependent

Creeping Flow spf 3D, 2D, 2D 
axisymmetric

stationary; time 
dependent

 Multiphase Flow

 Two-Phase Flow, Level Set

Laminar Two-Phase Flow, Level 
Set

tpf 3D, 2D, 2D 
axisymmetric

transient with 
initialization

 Two-Phase Flow, Phase Field

Laminar Two-Phase Flow, Phase 
Field

tpf 3D, 2D, 2D 
axisymmetric

transient with 
initialization

 Two-Phase Flow, Moving Mesh

Laminar Two-Phase Flow, 
Moving Mesh

tpfmm 3D, 2D, 2D 
axisymmetric

time dependent

 Porous Media and Subsurface Flow

Brinkman Equations br 3D, 2D, 2D 
axisymmetric

stationary; time 
dependent

Darcy’s Law dl all dimensions stationary; time 
dependent
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Free and Porous Media Flow fp 3D, 2D, 2D 
axisymmetric

stationary; time 
dependent

 Rarefied Flow

Slip Flow slpf 3D, 2D, 2D 
axisymmetric

stationary; time 
dependent

  Heat Transfer

Heat Transfer in Porous Media ht all dimensions stationary; time 
dependent

 Mathematics

 Moving Interface

Level Set ls all dimensions transient with 
initialization

Phase Field pf all dimensions time dependent; 
transient with 
initialization

* This is an enhanced interface, which is included with the base COMSOL package but has 
added functionality for this module.

Physics Icon Tag Space 
Dimension

Available Preset Study 
Type
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The Model Library

The Microfluidics Module Model Library illustrates the Microfluidics interfaces 
and the available features using tutorial examples. These examples include analyses 
of existing Microfluidic devices, tutorial models and benchmark models.
To open any Microfluidics Module model, select View>Model Library  from 
the main menu in COMSOL Multiphysics. In the Model Library window that 
opens, expand the Microfluidics Module folder and browse or search the contents 
of the folders. Click Open Model and PDF to open both the model in COMSOL 
Multiphysics and a PDF to read background theory including the step-by-step 
instructions on how to build it.
The Model Library is updated on a regular basis by COMSOL in order to add new 
models and to improve existing models. Choose View>Model Library Update 
( ) to update the model library.
The MPH-files in the COMSOL model libraries can have two formats—Full 
MPH-files or Compact MPH-files.
• Full MPH-files, including all meshes and solutions. In the Model Library 

these models appear with the  icon. If the MPH-file’s size exceeds 25MB, 
a tip with the text “Large file” and the file size appears when you position 
the cursor at the model’s node in the Model Library tree.

• Compact MPH-files with all settings for the model but without built meshes 
and solution data to save space on the DVD (a few MPH-files have no 
solutions for other reasons). You can open these models to study the settings 
and to mesh and re-solve the models. It is also possible to download the full 
versions—with meshes and solutions—of most of these models through 
Model Library Update. In the Model Library these models appear with the 

 icon. If you position the cursor at a compact model in the Model Library 
window, a No solutions stored message appears. If a full MPH-file is 
available for download, the corresponding node’s context menu includes a 
Model Library Update item.

A model from the Model Library is used as a tutorial in this guide. See “Tutorial 
Example: A Controlled Diffusion Micromixer” on page 16.



This model is licensed under the COMSOL Software License Agreement 5.2a.
All trademarks are the property of their respective owners. See www.comsol.com/trademarks.

Created in COMSOL Multiphysics 5.2a

Con t r o l l e d  D i f f u s i o n  M i c r om i x e r 1

1. This example was originally formulated by Albert Witarsa under Professor Bruce Finlayson’s supervision at the University of Washington in Seattle. 
It was part of a graduate course in which the assignment consisted of using mathematical modeling to evaluate the potential of patents in the field of 
microfluidics.

http://www.comsol.com/sla
http://www.comsol.com/trademarks/
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Introduction

This model treats an H-shaped microfluidic device for controlled mixing through 
diffusion. The device puts two different laminar streams in contact for a controlled period 
of time. The contact surface is well defined, and by controlling the flow rate it is possible 
to control the amount of species transported from one stream to the other through 
diffusion. The device concept is illustrated in Figure 1.

Figure 1: Diagram of the device.

Model Definition

The geometry of the device is shown in Figure 2. The device geometry is split in two 
because of symmetry. The design aims to maintain a laminar flow field when the two 
streams, A and B, are united and thus prevent uncontrolled convective mixing. The 
transport of species between streams A and B should take place only by diffusion in order 
that species with low diffusion coefficients stay in their respective streams.

Diffusion perpendicular to 
the flow transports species 
from stream A to stream B

Outlet AInlet A

Stream A

Outlet BInlet B

Stream B
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Figure 2: Model geometry. To avoid any type of convective mixing, the design must smoothly 
let both streams come in contact with each other. Due to symmetry, it is sufficient to model half 
the geometry, so the actual channel is twice as high in the z-direction.

The flow rate at the inlet is approximately 0.1 mm/s. The Reynolds number, which is 
important for characterizing the flow is given by:

where ρ is the fluid density (1000 kg/m3), U is a characteristic velocity of the flow 
(0.1 mm/s), μ is the fluid viscosity (1 mPa⋅s) and L is a characteristic dimension of the 
device (10 μm). When the Reynolds number is significantly less than 1, as in this example, 
the Creeping Flow interface can be used. The convective term in the Navier-Stokes 
equations can be dropped, leaving the incompressible Stokes equations:

where u is the local velocity (m/s) and p is the pressure (Pa).

Mixing in the device involves species at relatively low concentrations compared to the 
solvent, in this case water. This means that the solute molecules interact only with water 

Symmetry plane (blue)

Re ρUL
μ

------------ 0,001= =

∇ pI– μ u∇ u∇( )T
+( )+( )⋅ 0=

∇ u⋅ 0=
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molecules, and Fick’s law can be used to describe the diffusive transport. The mass-balance 
equation for the solute is therefore:

where D is the diffusion coefficient of the solute (m2/s) and c is its concentration (mol/
m3). Diffusive flows can be characterized by another dimensionless number: the Peclet 
number, which is given by:

In this model, the parametric solver is used to solve Equation 1 for three different species, 
each with different values of D: 1×10-11 m2/s, 5×10-11 m2/s, and 1×10-10 m2/s. These 
values of D correspond to Peclet numbers of 100, 20 and 10 respectively. Since these 
Peclet numbers are all greater than 1, implying a cell Peclet number significantly greater 
than 1, numerical stabilization is required when solving Fick’s equation. COMSOL 
automatically includes the stabilization by default, so no explicit settings are required.

Two versions of the model are solved:

• In the first version, it is assumed that a change in solute concentration does not 
influence the fluid’s density and viscosity. This implies that it is possible to first solve the 
Navier-Stokes equations and then solve the mass balance equation.

• In the second version, the viscosity depends quadratically on the concentration:

Here α is a constant of dimension m6/(mol)2 and μ0 is the viscosity at zero concentration. 
Such a relationship between concentration and viscosity is usually observed in solutions of 
larger molecules.

∇ D c∇– cu+( )⋅– 0=

Pe LU
D
---------=

μ μ0 1 αc2
+( )=
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Results and Discussion

Figure 3 shows the velocity field for the case where viscosity is concentration independent. 
The flow is symmetric and is not influenced by the concentration field. Figure 4 shows the 
corresponding pressure distribution on the channel walls that results from the flow.
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Figure 3: Flow velocity field.

Figure 4: Pressure distribution on the channel walls.
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Figure 5: Concentration distribution for a species with diffusivity 1·10-11 m2/s.

Figure 6: Concentration distribution for a species with diffusivity 5·10-11 m2/s.
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Figure 7: Concentration distribution for a species with diffusivity 1·10-10 m2/s.

Figure 8: Average concentration at the outlet of stream B as a function of the diffusion 
coefficient.
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Figure 5, Figure 6 and Figure 7 show the species concentration for the each of the three 
diffusion coefficients. For the heaviest species, which has the smallest diffusivity, there is 
almost no significant mixing between streams A and B (Figure 5). For the lightest species, 
which has the largest diffusion coefficient, the mixing is almost perfect (Figure 7). 
Figure 8 shows how the mean concentration of the species at the outlet of stream B varies 
for the different species diffusion coefficients. The simulation clearly shows that the device 
could be used to separate lighter molecules from heavier ones. By placing a number of 
these devices in series, a high degree of separation could be obtained.

In some cases, especially those involving solutions of macromolecules, the macromolecule 
concentration has a large influence on the liquid’s viscosity. In such situations, the 
Navier-Stokes and the convection-diffusion equations become coupled, and so they must 
be solved simultaneously. Figure 9, Figure 10, and Figure 11 show the results of such a 
simulation, in which the Navier Stokes equations are solved with a concentration 
dependent viscosity. In this case the species with for the species with diffusivity 5·10−11 
m2/s. The velocity field is altered slightly by the concentration dependent viscosity (see 
Figure 12) but this has little effect on the mean stream A outlet concentration, which 
changes only slightly from 0.450 to 0.451. Much more serious is the effect of the 
non-uniform viscosity on the pressure distribution required to maintain the two streams 
at the same flow rate. A larger pressure is required at the inlet of stream B to drive the 
higher viscosity fluid through the system. This asymmetry in the pressure distribution 
makes placing several devices in series much more difficult.
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Figure 9: Velocity field. The viscosity varies with the concentration according to μ= μ0(1 + α 
c2) with α = 0.5 (m3/mol)2. It is difficult to see the differences between this figure and that 
in Figure 3, but careful inspection reveals a slight change in the velocity profile. This is 
highlighted further in Figure 12.

Figure 10: Pressure distribution. The viscosity varies with the concentration according to 
μ= μ0(1 + α c2) with α = 0.5 (m3/mol)2. This figure should be compared to Figure 4. There 
are significant differences between the two cases.
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Figure 11: Concentration distribution for the species with diffusivity 5·10-11 m2/s for the case 
where the fluid viscosity varies with concentration. This plot is very similar to the corresponding 
plot for an uncoupled flow, shown in Figure 6.

Figure 12: Comparison of the velocity field for the uncoupled and coupled flow simulations 
showing the difference between the two cases. The coupled flow, in which the fluid viscosity is a 
function of concentration, is asymmetric.
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Application Library path: Microfluidics_Module/Micromixers/
controlled_diffusion_micromixer

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 In the Select Physics tree, select Fluid Flow>Single-Phase Flow>Creeping Flow (spf).

3 Click Add.

4 In the Select Physics tree, select Chemical Species Transport>Transport of Diluted Species 

(tds).

5 Click Add.

6 Click Study.

7 In the Select Study tree, select Preset Studies for Selected Physics Interfaces>Stationary.

8 Click Done.

G E O M E T R Y  1

For many microfluidic devices it is convenient to specify the geometry dimensions using 
micrometers.

1 In the Model Builder window, under Component 1 (comp1) click Geometry 1.

2 In the Settings window for Geometry, locate the Units section.

3 From the Length unit list, choose µm.

The geometry can be constructed by extruding a 2 dimensional workplane. First draw 
a top down view of the structure in the workplane.

Work Plane 1 (wp1)
1 On the Geometry toolbar, click Work Plane.

2 In the Settings window for Work Plane, click Show Work Plane.
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Rectangle 1 (r1)
1 On the Work Plane toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type 140.

4 In the Height text field, type 60.

5 Right-click Rectangle 1 (r1) and choose Build Selected.

Rectangle 2 (r2)
1 On the Work Plane toolbar, click Primitives and choose Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type 120.

4 In the Height text field, type 50.

5 Locate the Position section. In the xw text field, type 10.

6 In the yw text field, type 10.

7 Right-click Rectangle 2 (r2) and choose Build Selected.

Difference 1 (dif1)
1 On the Work Plane toolbar, click Booleans and Partitions and choose Difference.

2 Select the object r1 only.

3 In the Settings window for Difference, locate the Difference section.

4 Find the Objects to subtract subsection. Select the Active toggle button.

5 Select the object r2 only.

6 Right-click Difference 1 (dif1) and choose Build Selected.

Fillet 1 (fil1)
1 On the Work Plane toolbar, click Fillet.

2 On the object dif1, select Points 3 and 5 only.

3 In the Settings window for Fillet, locate the Radius section.

4 In the Radius text field, type 10.

5 Right-click Fillet 1 (fil1) and choose Build Selected.

Fillet 2 (fil2)
1 On the Work Plane toolbar, click Fillet.

2 On the object fil1, select Points 1 and 9 only.

3 In the Settings window for Fillet, locate the Radius section.
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4 In the Radius text field, type 20.

5 Right-click Fillet 2 (fil2) and choose Build Selected.

Mirror 1 (mir1)
1 On the Work Plane toolbar, click Transforms and choose Mirror.

2 Select the object fil2 only.

3 In the Settings window for Mirror, locate the Input section.

4 Select the Keep input objects check box.

5 Locate the Normal Vector to Line of Reflection section. In the xw text field, type 0.

6 In the yw text field, type 1.

7 Right-click Mirror 1 (mir1) and choose Build Selected.

Union 1 (uni1)
1 On the Work Plane toolbar, click Booleans and Partitions and choose Union.

2 Click in the Graphics window and then press Ctrl+A to select both objects.

3 In the Settings window for Union, locate the Union section.

4 Clear the Keep interior boundaries check box.

5 Right-click Union 1 (uni1) and choose Build Selected.

Extrude the 2D geometry to create a 3 dimensional geometry.

Work Plane 1 (wp1)
In the Model Builder window, under Component 1 (comp1)>Geometry 1 click Work Plane 1 

(wp1).

Extrude 1 (ext1)
1 On the Geometry toolbar, click Extrude.

2 In the Settings window for Extrude, locate the Distances from Plane section.

3 In the table, enter the following settings:

4 Right-click Extrude 1 (ext1) and choose Build Selected.

Distances (µm)

10
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5 Click the Zoom Extents button on the Graphics toolbar.

Create parameters to define the model.

G L O B A L  D E F I N I T I O N S

Parameters
1 On the Home toolbar, click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.

3 In the table, enter the following settings:

Create an average operator to compute the mean output concentration.

Name Expression Value Description

D 5e-11[m^2/s] 5E-11 m²/s Diffusion constant

fr 15[pl/s] 1.5E-14 m³/s Inlet flow rate

c0 1[mol/m^3] 1 mol/m³ Inlet concentration

alpha 0.5[(m^3/mol)^2] 0.5 m^6/mol² Viscosity c^2-term 
prefactor
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D E F I N I T I O N S

Average 1 (aveop1)
1 On the Definitions toolbar, click Component Couplings and choose Average.

2 In the Settings window for Average, locate the Source Selection section.

3 From the Geometric entity level list, choose Boundary.

4 Select Boundary 22 only.

Add material properties to the model.

M A T E R I A L S

In the Model Builder window, under Component 1 (comp1) right-click Materials and choose 
Blank Material.

Material 1 (mat1)
1 In the Settings window for Material, locate the Material Contents section.

2 In the table, enter the following settings:

C R E E P I N G  F L O W  ( S P F )

Add a Laminar flow inlet boundary condition.

Inlet 1
1 On the Physics toolbar, click Boundaries and choose Inlet.

2 Select Boundary 2 only.

3 In the Settings window for Inlet, locate the Boundary Condition section.

4 From the list, choose Laminar inflow.

5 Locate the Laminar Inflow section. Click the Flow rate button.

6 In the V0 text field, type fr/2.

Set the flow rate to one half of the parameter value, since only half of the geometry is 
modeled.

7 In the Lentr text field, type 100[um].

The entrance length should be set to a value large enough for a laminar flow to develop.

Property Name Value Unit Property group

Density rho 1000 kg/m³ Basic

Dynamic viscosity mu 1e-3 Pa·s Basic



17 |  C O N T R O L L E D  D I F F U S I O N  M I C R O M I X E R

Inlet 2
1 Right-click Inlet 1 and choose Duplicate.

2 In the Settings window for Inlet, locate the Boundary Selection section.

3 Click Clear Selection.

4 Select Boundary 8 only.

Add an outlet with a Pressure boundary condition.

Outlet 1
1 On the Physics toolbar, click Boundaries and choose Outlet.

2 Select Boundaries 20 and 22 only.

The default pressure of 0 Pa is appropriate in this case.

Add a Symmetry boundary condition in the symmetry plane.

Symmetry 1
1 On the Physics toolbar, click Boundaries and choose Symmetry.

2 Select Boundary 4 only.

Now set up the mass transport physics.

TR A N S P O R T  O F  D I L U T E D  S P E C I E S  ( T D S )

Transport Properties 1
Use the computed velocity field for the species convection.

1 In the Model Builder window, expand the Component 1 (comp1)>Transport of Diluted 

Species (tds) node, then click Transport Properties 1.

2 In the Settings window for Transport Properties, locate the Model Inputs section.

3 From the u list, choose Velocity field (spf).

The diffusion coefficient is set to use the parameter previously defined.

4 Locate the Diffusion section. In the Dc text field, type D.

Specify the concentration at the two inlets.

5 In the Model Builder window, click Transport of Diluted Species (tds).

Concentration 1
1 On the Physics toolbar, click Boundaries and choose Concentration.

2 Select Boundary 2 only.

3 In the Settings window for Concentration, locate the Concentration section.

4 Select the Species c check box.
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5 In the c0,c text field, type c0.

Concentration 2
1 On the Physics toolbar, click Boundaries and choose Concentration.

2 Select Boundary 8 only.

3 In the Settings window for Concentration, locate the Concentration section.

4 Select the Species c check box.

In this case the concentration should take the default value of 0.

Use the Outflow condition to allow species to leave the domain by convection.

Outflow 1
1 On the Physics toolbar, click Boundaries and choose Outflow.

2 In the Settings window for Outflow, locate the Boundary Selection section.

3 Click Paste Selection.

4 In the Paste Selection dialog box, type 20 22 in the Selection text field.

5 Click OK.

Set up the mesh. Microfluidic devices are frequently extruded 2D geometries. It is 
therefore frequently convenient to extrude a 2D mesh. First mesh the top face of the 
device with a 2D quad mesh.

M E S H  1

In the Model Builder window, under Component 1 (comp1) right-click Mesh 1 and choose 
More Operations>Free Quad.

Free Quad 1
Select Boundary 4 only.

Size
1 In the Model Builder window, under Component 1 (comp1)>Mesh 1 click Size.

2 In the Settings window for Size, locate the Element Size section.

3 From the Calibrate for list, choose Fluid dynamics.

4 From the Predefined list, choose Coarse.

Next, sweep the mesh through the domain.

Swept 1
1 In the Model Builder window, right-click Mesh 1 and choose Swept.



19 |  C O N T R O L L E D  D I F F U S I O N  M I C R O M I X E R

2 In the Settings window for Swept, click Build All.

Now set up a study to solve the problem. Initially it is assumed that the fluid flow and 
diffusion problems are uncoupled. In this case it makes sense to solve the fluid flow 
problem first and then to use the velocity field as an input for the diffusion problem. 
This will save time and memory, particularly since the diffusion problem is solved for 
three parameters.

S T U D Y  1

Since the study will automatically generate a large number of default plots, default plots 
are disabled.

1 In the Settings window for Study, locate the Study Settings section.

2 Clear the Generate default plots check box.

For Step 1, solve only the creeping flow problem.

Step 1: Stationary
1 In the Model Builder window, under Study 1 click Step 1: Stationary.

2 In the Settings window for Stationary, locate the Physics and Variables Selection section.

3 In the table, clear the Solve for check box for the Transport of Diluted Species interface.

Add a second study step.
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Stationary 2
On the Study toolbar, click Study Steps and choose Stationary>Stationary.

Step 2: Stationary 2
Disable the solution of the creeping flow problem for this step, but import the previously 
computed solution into the relevant dependent variables so that they can be used to 
compute the convective species transport.

1 In the Settings window for Stationary, locate the Physics and Variables Selection section.

2 In the table, clear the Solve for check box for the Creeping Flow interface.

3 Click to expand the Values of dependent variables section. Locate the Values of Dependent 

Variables section. Find the Values of variables not solved for subsection. From the Settings 
list, choose User controlled.

4 From the Method list, choose Solution.

5 From the Study list, choose Study 1, Stationary.

Solve the diffusion problem for three values of the diffusion coefficient.

6 Click to expand the Study extensions section. Locate the Study Extensions section. Select 
the Auxiliary sweep check box.

7 Click Add.

8 In the table, enter the following settings:

9 On the Study toolbar, click Compute.

Create a Surface data set to view the pressure on the channel walls.

R E S U L T S

Surface 1
1 On the Results toolbar, click More Data Sets and choose Surface.

2 Select Boundaries 1, 3, 5–7, 9–19, 21, 23, and 24 only.

First plot the velocity of the flow within the channel.

3D Plot Group 1
1 On the Results toolbar, click 3D Plot Group.

Use a Slice plot to view the data on one or more slices through the geometry.

Parameter name Parameter value list Parameter unit

D 1e-10 5e-11 1e-11
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Slice 1
1 In the Model Builder window, right-click 3D Plot Group 1 and choose Slice.

2 In the Settings window for Slice, locate the Expression section.

3 From the Unit list, choose mm/s.

3D Plot Group 1
Add additional slices in different directions.

Slice 2
1 In the Model Builder window, under Results right-click 3D Plot Group 1 and choose Slice.

2 In the Settings window for Slice, locate the Expression section.

3 From the Unit list, choose mm/s.

4 Locate the Plane Data section. From the Plane list, choose xy-planes.

5 In the Planes text field, type 1.

The extra slices should use the same scale and colors for the velocity plot as the existing 
slice.

6 Click to expand the Inherit style section. Locate the Inherit Style section. From the Plot 
list, choose Slice 1.

To avoid duplicate titles, turn off the title for additional slices.

7 Click to expand the Title section. From the Title type list, choose None.

Add slices in a third plane.

Slice 3
1 Right-click Results>3D Plot Group 1>Slice 2 and choose Duplicate.

2 In the Settings window for Slice, locate the Plane Data section.

3 From the Plane list, choose zx-planes.

4 In the Planes text field, type 2.

Use the Arrow Volume plot to visualize the flow direction.

3D Plot Group 1
In the Model Builder window, under Results right-click 3D Plot Group 1 and choose Arrow 

Volume.

Arrow Volume 1
1 In the Settings window for Arrow Volume, locate the Arrow Positioning section.

2 Find the x grid points subsection. In the Points text field, type 14.

3 Find the y grid points subsection. In the Points text field, type 21.
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4 Find the z grid points subsection. In the Points text field, type 3.

5 Locate the Coloring and Style section. From the Color list, choose Black.

Rename the plot.

3D Plot Group 1
1 Right-click 3D Plot Group 1 and choose Rename.

2 In the Rename 3D Plot Group dialog box, type Velocity (uncoupled flow) in the New 

label text field.

3 Click OK.

4 On the Velocity (uncoupled flow) toolbar, click Plot.

Next add a pressure plot, using the data set created previously.

3D Plot Group 2
1 On the Home toolbar, click Add Plot Group and choose 3D Plot Group.

2 In the Settings window for 3D Plot Group, locate the Data section.

3 From the Data set list, choose Surface 1.

First add a uniformly colored surface, to highlight the channel walls.

Surface 1
1 Right-click 3D Plot Group 2 and choose Surface.
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2 In the Settings window for Surface, locate the Expression section.

3 In the Expression text field, type 1.

4 Locate the Coloring and Style section. From the Coloring list, choose Uniform.

5 From the Color list, choose Gray.

Next use contours to visualize the pressure.

3D Plot Group 2
In the Model Builder window, under Results right-click 3D Plot Group 2 and choose Contour.

Contour 1
1 In the Settings window for Contour, click Replace Expression in the upper-right corner 

of the Expression section. From the menu, choose Model>Component 1>Creeping Flow>

Velocity and pressure>p - Pressure.

Finally rename the plot.

3D Plot Group 2
1 Right-click 3D Plot Group 2 and choose Rename.

2 In the Rename 3D Plot Group dialog box, type Pressure (uncoupled flow) in the New 

label text field.

3 Click OK.
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4 On the Pressure (uncoupled flow) toolbar, click Plot.

Next create a Slice plot to visualize the concentration in the device. Use the existing 
velocity slice plot as a basis for this plot.

Velocity (uncoupled flow)
In the Model Builder window, under Results right-click Velocity (uncoupled flow) and choose 
Duplicate.

Velocity (uncoupled flow) 1
Re-name the plot.

1 In the Model Builder window, under Results right-click Velocity (uncoupled flow) 1 and 
choose Rename.

2 In the Rename 3D Plot Group dialog box, type Concentration (uncoupled flow) in 
the New label text field.

3 Click OK.

For each of the slice sub-nodes, change the plotted quantity to concentration.

Slice 1
1 In the Model Builder window, expand the Results>Concentration (uncoupled flow) node, 

then click Slice 1.
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2 In the Settings window for Slice, click Replace Expression in the upper-right corner of the 
Expression section. From the menu, choose Model>Component 1>Transport of Diluted 

Species>c - Concentration.

Slice 2
1 In the Model Builder window, under Results>Concentration (uncoupled flow) click Slice 2.

2 In the Settings window for Slice, click Replace Expression in the upper-right corner of the 
Expression section. From the menu, choose c - Concentration.

Slice 3
1 In the Model Builder window, under Results>Concentration (uncoupled flow) click Slice 3.

2 In the Settings window for Slice, click Replace Expression in the upper-right corner of the 
Expression section. From the menu, choose c - Concentration.

Disable the Arrow Volume plot.

Arrow Volume 1
In the Model Builder window, under Results>Concentration (uncoupled flow) right-click 
Arrow Volume 1 and choose Disable.

Concentration (uncoupled flow)
1 In the Model Builder window, under Results click Concentration (uncoupled flow).

2 On the Concentration (uncoupled flow) toolbar, click Plot.

Look at the plot for each of the three diffusion coefficient levels.

The plots on the next page show the results for each of the diffusion coefficients solved 
for. For the heaviest species, which has the smallest diffusivity, there is limited mixing 
between streams A and B. For the lightest species, which has the largest diffusion 
coefficient, the mixing is almost perfect.
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3 Click Plot.

4 In the Settings window for 3D Plot Group, locate the Data section.

5 From the Parameter value (D) list, choose 5E-11.

6 On the Concentration (uncoupled flow) toolbar, click Plot.

7 From the Parameter value (D) list, choose 1E-10.
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8 On the Concentration (uncoupled flow) toolbar, click Plot.

Add a Global plot to show how the concentration at the output differs with diffusion 
coefficient.

1D Plot Group 4
On the Home toolbar, click Add Plot Group and choose 1D Plot Group.

Global 1
1 On the 1D Plot Group 4 toolbar, click Global.

Use the previously defined average operator to compute the average concentration at 
the device output.

2 In the Settings window for Global, locate the y-Axis Data section.

3 In the table, enter the following settings:

No legend is necessary for this plot, as only one quantity is plotted.

4 Click to expand the Legends section. Clear the Show legends check box.

Add a marker in the computed datapoints.

5 Click to expand the Coloring and style section. Locate the Coloring and Style section. Find 
the Line markers subsection. From the Marker list, choose Point.

Expression Unit Description

aveop1(c) mol/m^3
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6 From the Positioning list, choose In data points.

Change the axis titles. Note that html tags and a range of mathematical symbols and 
Greek letters can be entered in the axis and plot titles.

1D Plot Group 4
1 In the Model Builder window, under Results click 1D Plot Group 4.

2 In the Settings window for 1D Plot Group, locate the Plot Settings section.

3 Select the x-axis label check box.

4 In the associated text field, type Diffusion Coefficient (m<sup>2</sup>/s).

5 Select the y-axis label check box.

6 In the associated text field, type Concentration at Stream B Outlet (mol/m<sup>
3</sup>).

Change the axis limits for the plot.

7 Click to expand the Axis section. Select the Manual axis limits check box.

8 In the y minimum text field, type 0.

9 In the y maximum text field, type 0.5.

Finally re-name the plot.

10 Right-click Results>1D Plot Group 4 and choose Rename.

11 In the Rename 1D Plot Group dialog box, type Output Concentration (uncoupled 
flow) in the New label text field.

12 Click OK.
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13 On the Output Concentration (uncoupled flow) toolbar, click Plot.

This plot shows that the concentration of the species at the output is strongly dependent 
on the diffusion coefficient of the molecule. Thus the device could be used to separate 
species with different diffusion coefficients, particularly if multiple stages of the device 
were arranged in series.

In some cases, particularly if the solution consists of large macromolecules, the dissolved 
species has a large influence on the liquid’s viscosity. In such situations, the 
Navier-Stokes and the convection-diffusion equations become coupled, and so they 
must be solved simultaneously.

Now set up the fully coupled problem. To make the viscosity a function of the species 
concentration simply type an expression into the Dynamic viscosity field of the Fluid 

Properties node.

C R E E P I N G  F L O W  ( S P F )

On the Physics toolbar, click Transport of Diluted Species (tds) and choose Creeping Flow 

(spf).

Fluid Properties 1
1 In the Model Builder window, under Component 1 (comp1)>Creeping Flow (spf) click Fluid 

Properties 1.



30 |  C O N T R O L L E D  D I F F U S I O N  M I C R O M I X E R

2 In the Settings window for Fluid Properties, locate the Fluid Properties section.

3 From the μ list, choose User defined. In the associated text field, type 1e-3[Pa*s]*(1+
alpha*c^2).

Add a study to solve the fully coupled problem. In this instance only a single diffusion 
coefficient will be solved for, so no parametric sweep will be required. The model will 
default to the parameter entered on the Parameters node for the diffusion constant: 
5e-11 m^2/s.

A D D  S T U D Y

1 On the Home toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select Preset Studies>Stationary.

4 Click Add Study in the window toolbar.

S T U D Y  2

Turn off the default plot groups again.

1 In the Model Builder window, click Study 2.

2 In the Settings window for Study, locate the Study Settings section.

3 Clear the Generate default plots check box.

4 On the Home toolbar, click Compute.

Add another surface data set that points to the new solution.

R E S U L T S

Surface 1
In the Model Builder window, under Results>Data Sets right-click Surface 1 and choose 
Duplicate.

Surface 2
1 In the Settings window for Surface, locate the Data section.

2 From the Data set list, choose Study 2/Solution 3 (sol3).

Re-create the velocity, pressure and concentration plots for the fully coupled problem.

Velocity (uncoupled flow)
In the Model Builder window, under Results right-click Velocity (uncoupled flow) and choose 
Duplicate.
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Velocity (uncoupled flow) 1
1 In the Settings window for 3D Plot Group, locate the Data section.

2 From the Data set list, choose Study 2/Solution 3 (sol3).

3 Right-click Results>Velocity (uncoupled flow) 1 and choose Rename.

4 In the Rename 3D Plot Group dialog box, type Velocity (coupled flow) in the New 

label text field.

5 Click OK.

6 On the Velocity (coupled flow) toolbar, click Plot.

There are significant differences in the flow pattern, although these are hard to see when 
comparing this plot with the similar one generated previously. The flow through a slice 
of the channel will be investigated in more detail later to better highlight these 
differences.

Pressure (uncoupled flow)
In the Model Builder window, under Results right-click Pressure (uncoupled flow) and choose 
Duplicate.

Pressure (uncoupled flow) 1
1 In the Settings window for 3D Plot Group, locate the Data section.

2 From the Data set list, choose Surface 2.
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3 Right-click Results>Pressure (uncoupled flow) 1 and choose Rename.

4 In the Rename 3D Plot Group dialog box, type Pressure (coupled flow) in the New 

label text field.

5 Click OK.

6 On the Pressure (coupled flow) toolbar, click Plot.

The pressure distribution in the channel has changed significantly as a result of the 
increased viscosity of the fluid that contains the added species. Thus the two inlets must 
be maintained at different pressures. This may be possible for a single stage, but it would 
significantly complicate the design of a multiple stage device.

Concentration (uncoupled flow)
In the Model Builder window, under Results right-click Concentration (uncoupled flow) and 
choose Duplicate.

Concentration (uncoupled flow) 1
1 In the Settings window for 3D Plot Group, locate the Data section.

2 From the Data set list, choose Study 2/Solution 3 (sol3).

3 Right-click Results>Concentration (uncoupled flow) 1 and choose Rename.

4 In the Rename 3D Plot Group dialog box, type Concentration (coupled flow) in the 
New label text field.
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5 Click OK.

6 On the Concentration (coupled flow) toolbar, click Plot.

The concentration distribution is affected only slightly by the coupling between the 
flow and the concentration.

Next add a Cut Plane data set in the center of the channel, for both the uncoupled and 
fully coupled solutions. These will be used to visualize the change in the flow profile 
induced by the coupling.

Cut Plane 1
1 On the Results toolbar, click Cut Plane.

2 In the Settings window for Cut Plane, locate the Plane Data section.

3 In the x-coordinate text field, type 70.

Cut Plane 2
1 Right-click Cut Plane 1 and choose Duplicate.

2 In the Settings window for Cut Plane, locate the Data section.

3 From the Data set list, choose Study 2/Solution 3 (sol3).

Cut Plane 1
Then add a Contour plot of the velocity magnitude.
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2D Plot Group 8
1 On the Results toolbar, click 2D Plot Group.

2 In the Settings window for 2D Plot Group, locate the Data section.

3 From the Data set list, choose Cut Plane 1.

4 From the Parameter value (D) list, choose 5E-11.

Contour 1
1 Right-click 2D Plot Group 8 and choose Contour.

2 In the Settings window for Contour, locate the Levels section.

3 In the Total levels text field, type 5.

Create a duplicate Contour plot, using the same colors and scales, but showing the 
coupled data.

Contour 2
1 Right-click Results>2D Plot Group 8>Contour 1 and choose Duplicate.

2 In the Settings window for Contour, locate the Data section.

3 From the Data set list, choose Cut Plane 2.

4 Click to expand the Title section. From the Title type list, choose None.

5 Click to expand the Inherit style section. Locate the Inherit Style section. From the Plot 
list, choose Contour 1.

2D Plot Group 8
Rename the plot.

1 In the Model Builder window, under Results right-click 2D Plot Group 8 and choose 
Rename.

2 In the Rename 2D Plot Group dialog box, type Velocity Comparison in the New label 
text field.

3 Click OK.

4 On the Velocity Comparison toolbar, click Plot.
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5 Click the Zoom Extents button on the Graphics toolbar.

Now it is possible to compare the velocity distributions more carefully. It is clear that 
the coupling has introduced an asymmetry into the flow pattern, as a result of the higher 
viscosity in the fluid containing the dissolved species.

Finally compare the output concentration between the two solutions.

Global Evaluation 1
1 On the Results toolbar, click Global Evaluation.

2 In the Settings window for Global Evaluation, locate the Expressions section.

3 In the table, enter the following settings:

4 Click Evaluate.

Global Evaluation 2
1 Right-click Global Evaluation 1 and choose Duplicate.

2 In the Settings window for Global Evaluation, locate the Data section.

3 From the Data set list, choose Study 2/Solution 3 (sol3).

4 Click New Table.

Expression Unit Description

aveop1(c) mol/m^3
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TA B L E

1 Go to the Table window.

Only a small difference occurs in the output concentration as a result of the coupling 
between the problems. However the coupling would make adding multiple stages of the 
device together much more difficult, as different pressures are required at the two inlets 
to obtain the same flow velocity in the two streams.
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